
GỢI Ý NỘI DUNG QUYỂN LUẬN VĂN 

Chương 1: Giới thiệu 

1.1. Đặt vấn đề, mục tiêu luận văn 

1.2. Những thách thức cần giải quyết (đề nghị Giáo viên gợi ý cho sinh viên các cách thức về 

mặt kỹ thuật/nghiệp vụ có thể gặp phải khi thực hiện luận văn) 

1.3. Nội dung, phạm vi thực hiện 

1.4. Kết quả cần đạt (nên lập bảng các kết quả cần đạt, tiêu chí để đánh giá cho mỗi kết quả 

đó, nên có cả kết quả chức năng và phi chức năng (vd: hiệu năng, chịu tải, bảo mật, …)) 

Chương 2: Phương pháp thực hiện 

2.1. Các hệ thống tương tự (khảo sát vài hệ thống có sẵn, đánh giá ưu/nhược điểm) 

2.2. Cơ sở lý thuyết (nếu làm nghiên cứu, còn làm ứng dụng thì bỏ phần này) 

2.3. Công nghệ sử dụng (liệt kê có kèm mô tả sơ lược các công nghệ sử dụng trong luận văn) 

2.4. Phân tích yêu cầu 

2.4.1 Các quy trình, nghiệp vụ (nên mô tả cụ thể các quy trình, nghiệp vụ trong ứng dụng, 

nên kèm theo các sơ đồ minh họa) 

2.4.2 Sơ đồ chức năng 

2.4.3 Sơ đồ Use case tổng quát (nhớ kèm theo mô tả các Actor, mô tả sơ lược các Use 

case) 

Chương 3: Thiết kế 

3.1. Mô hình dữ liệu (mức ý niệm, mức luận lý, mức vật lý) 

3.2. Mô hình xử lý 

3.2.1 Use case chi tiết (kèm các bảng mô tả) 

3.2.2 Sơ đồ tuần tự 

3.2.3 Sơ đồ hoạt động (activity) 

3.3. Hệ thống màn hình (thiết kế giao diện, yêu cầu sử dụng công cụ để thiết kế chứ không vẽ 

tay hay chụp màn hình) 

3.4. Hệ thống báo biểu (có thể có ở một số ứng dụng quản lý, nếu không có thì thôi) 

Chương 4: Thử nghiệm (khuyến khích sinh viên làm thêm phần này nếu có thời gian, sẽ là 

điểm cộng) 

4.1. Các kịch bản thử nghiệm 

4.2. Kết quả thử nghiệm các kịch bản 

4.3. Xử lý các trường hợp ngoại lệ 

Chương 5: Kết luận 

5.1. Kết quả đối chiếu với mục tiêu (lập bảng dựa theo mục 1.4 và có thêm kết quả đánh giá 

đạt/không đạt, giải thích nếu không đạt) 

5.2. Các vấn đề còn tồn đọng 

5.3. Mở rộng (hướng phát triển) 

Phụ lục: Hướng dẫn sử dụng (Yêu sinh viên làm hướng dẫn sử dụng cho tối thiểu 1 quy 

trình chính của ứng dụng) 

 

Lưu ý: đây chỉ là gợi ý của Khoa CNTT về cấu trúc chung cho nội dung 

quyển luận văn, còn cấu trúc cụ thể của từng luận văn do GVHD quyết 

định nhưng nên cố gắng bám sát theo cấu trúc này.  



 

QUY ĐỊNH VỀ ĐỊNH DẠNG VÀ ĐÓNG QUYỂN LVTN 

1. Page Layout: chọn khổ giấy A4, cài đặt kích thước như hình bên dưới. 

 

2. Định dạng cho trang bìa: 

✓ Định dạng khung (Page border): chọn kiểu viền đơn giản như hình mẫu bên dưới.   

✓ Kích thước font chữ, khoảng cách các dòng (paragraph) theo hình mẫu bên dưới.   

✓ Màu bìa quyển LVTN: 

▪ Hệ ĐẠI HỌC:  

 
▪ Hệ LIÊN THÔNG ĐẠI HỌC: 

 
▪ Hệ CAO ĐẲNG: 

MÀU XANH DƯƠNG 

MÀU HỒNG 

MÀU VÀNG 



 

 

TRƯỜNG ĐẠI HỌC CÔNG NGHỆ SÀI GÒN 

KHOA CÔNG NGHỆ THÔNG TIN 
---oOo--- 

 

 

 

 

 

 

 

LUẬN VĂN TỐT NGHIỆP 
 

 

 

 

 

 

 

 

 

 

Tên đề tài:  

XÂY DỰNG WEBSITE BÁN HÀNG 

TRỰC TUYẾN 

Người hướng dẫn: ThS. TRẦN VĂN A 

Sinh viên thực hiện:  

1. NGUYỄN VĂN C 

2. TRẦN VĂN D 

TP. HỒ CHÍ MINH – NĂM 20XX

BÌA 

Paragraph: sinh 

viên tự điều chỉnh 

khoảng cách đoạn 

cho phù hợp 

 

Paragraph: sinh 

viên tự điều chỉnh 

khoảng cách đoạn 

cho phù hợp 

 

Nếu chỉ có 1 sinh viên thì để như sau: 
 

Người hướng dẫn: ThS. TRẦN VĂN A 

Sinh viên thực hiện: NGUYỄN TRẦN P 

Font: 13 

Paragraph spacing: 

- Before: 0 pt 

- After: 0 pt 

Font: 16, Bold, 

UPPERCASE 

 

Font: 14, Italic, 

Underline 

 

Sinh viên tự điều chỉnh font 

size cho phù hợp, tối thiểu 

là 20, tối đa là 24 

 

Font: 13 

Font: 13 



 

 

  

LỜI CẢM ƠN Font: 18, Bold, 

UPPERCASE 



 

 

3. Lời cảm ơn: sử dụng shapes theo mẫu để trang trí. 

4. Mục lục:  

✓ Sử dụng mục lục tự động 

▪ Mục lục theo nội dung: theo hướng dẫn của GVHD, thường thì lấy nội dung 

của tiêu đề cấp 1,2,3, tối đa 4 cấp. Cách đánh chỉ mục của các chương/phần vui 

lòng xem ở mục 5. 

▪ Mục lục theo hình ảnh: lấy nội dung phần ghi chú hình ảnh. Ví dụ: 

 

 
 

 

 

 
  

Font: 18, Bold, 

UPPERCASE 

Font: 18, Bold, 

UPPERCASE 



 

 

5. Phần nội dung đề tài: 

Lưu ý: dưới đây chỉ quy định cách định dạng, cấu trúc nội dung của các 

chương/phần của luận văn thì tùy theo yêu cầu của GVHD. 

✓ Quy định chung: 

▪ Font: Times New Roman 

▪ Size: 13 

▪ Khoảng cách giữa các đoạn là: 6pt  

▪ Khoảng cách giữa các dòng (line spacing) là: 1,3 

 

 

 

✓ Quy định các tiêu đề chính: 

▪ Tiêu đề các trang mục lục: 

▪ Size: 18, chữ in hoa, in đậm 

▪ Canh giữa trang 

▪ Tiêu đề cấp 1:  

- Size: 24, chữ in hoa, in đậm 

- Dành cho các tiêu đề về Chương 1,2,3…hoặc Phần A,B,C… 

- Canh phải, không sử dụng header, footer. 

▪ Tiêu đề cấp 2:  

- Size: 15, chữ in hoa, in đậm 

- Dành cho các tiêu đề 1.1, 1.2, 1.3, 2.1, 2.2… 

▪ Tiêu đề cấp 3: 

- Size: 14, chữ thường, in đậm. 

- Dành cho tiêu đề của 1.1.1, 1.1.2 hoặc 1.2.1, 1.2.2… 

▪ Tiêu đề cấp 4: 

- Size: 13, chữ thường, gạch dưới. 

- Dành cho cho tiêu đề của 1.1.1.1, 1.1.1.2,… 

▪ Tiêu đề thấp nhất có cỡ chữ là 13 (dành cho tiêu đề của a., b., c., hoặc các dấu 

bullets…) 

Xem ví dụ ở trang sau: 



 

 

 

 

✓ Quy định về cách đặt header and footer:  

▪ Đặt tiêu đề đầu trang (Header): 

- Ở các trang có chứa tiêu đề cấp 1 (chương, phần…) không sử 

dụng header. 

- Các trang còn lại trong có sử dụng header, ghi tên chương (phần) 

mấy? Ghi nội dung header bằng chữ hoa, in nghiêng. (vd: 

Chương 1: GIỚI THIỆU) 

 

Có sử dụng Header 

FOOTER: giống nhau 

cho toàn bộ nội dung LV 

Không sử dụng Header 

HEADER: mỗi chương 

có 1 header khác nhau 



 

 

- Lưu ý: ở mỗi chương (hoặc phần…) có tiêu đề header chứa nội 

dung phù hợp với nội dung thuộc chương (phần) đó. 

- Hướng dẫn cách làm: Tìm hiểu cách tạo phân đoạn (section), tạo 

tiêu đề trong mỗi phân đoạn. 

▪ Đặt tiêu đề cuối trang (Footer): 

- Ở tất cả các footer của quyển LVTN có chứa nội dung là tên đề 

tài viết bằng chữ in hoa, nghiêng. Nếu tên đề tài quá dài thì có 

thể thu nhỏ font chữ để footer chỉ có 1 dòng. 

- Đánh số thứ tự trang liên tiếp nhau, bắt đầu từ phần nội dung 

của LVTN có số thứ tự từ 1 cho đến hết quyển LVTN, stt canh 

phải (xem hình trên). 

▪ Lưu ý: Chỉ làm Header và Footer bắt đầu từ nội dung LVTN, các trang mục 

lục trở về trước không đặt Header và Footer. 

✓ Quy định về hình ảnh: 

▪ Canh giữa, để hình ở chế độ Wrap text → In Line with Text 

▪ Phần chú thích hình: canh giữa, gạch dưới, in đậm, in nghiêng phần đánh số 

thứ tự (ví dụ hình bên dưới ở chương 5 hình số 2 được viết như sau: Hình 5-2) 

 

Hình 5-2: Use case của Nhân viên quản lý. 

 

 

 

 

Cách đánh kí hiệu này được hiểu 

rằng: hình số 2 ở chương 5 



 

 

6. Quy định về in ấn: 

▪ Nộp quyển lần 1: in 2 quyển, có thể in 2 mặt trên Giấy A4 (nếu không cần thiết 

thì không cần in màu). 

▪ Nộp quyển lần 2: in 1 quyển, in 1 mặt trên Giấy A4. 

▪ In tờ bìa bằng giấy màu cứng, màu bìa theo quy định của từng hệ, không đóng 

bìa kiếng. 

▪ Quyển LVTN tối thiểu 60 trang. 

7. Quy định cách xếp thứ tự khi đóng quyển LVTN 

▪ Bìa (in trên bìa cứng, giấy màu theo quy định ở mục 1). 

▪ Chèn tờ giấy trắng. 

▪ Tờ nhiệm vụ. 

▪ Lời cảm ơn. 

▪ Mục lục nội dung. 

▪ Mục lục hình ảnh hoặc sơ đồ. 

▪ Nội dung LVTN. 

▪ Phụ lục (nếu có).  

▪ Tài liệu tham khảo (nếu có). 

▪ Chèn tờ giấy trắng. 

▪ Tờ giấy màu cứng cùng màu với tờ bìa 1. 

 

 

 

 

CÁC TRANG BÊN DƯỚI LÀ VÍ DỤ VỀ CÁCH ĐẶT 

MỤC LỤC TỰ ĐỘNG, TIÊU ĐỀ HEADER,  

TIÊU ĐỀ FOOTER 
 



 

 

MỤC LỤC 

Chương 1. GIỚI THIỆU ............................................................................................. 1 

1.1 ĐẶT VẤN ĐỀ ............................................................................................. 1 

1.1.1 Giới thiệu bối cảnh chung của xã hội hay của đơn vị khai thác. ....... 1 

1.1.2 Sự phát triển của công nghệ ............................................................... 1 

1.2 MỤC TIÊU CỦA ĐỀ TÀI .......................................................................... 1 

Chương 2. MÔ TẢ NGHIỆP VỤ ............................................................................... 3 

2.1 TỔNG QUAN ............................................................................................. 3 

2.1.1 Giới thiệu ........................................................................................... 3 

2.1.2 Cơ cấu tổ chức .................................................................................... 3 

2.2 QUY TRÌNH ĐẶT HÀNG.......................................................................... 3 

    

Chú ý cách thụt đầu 

dòng ở trang mục 

lục: chỉ số của cấp 

con phải thụt đầu 

dòng sao cho thẳng 

hàng với chữ của cấp 

cha 

Không có 

Header và 

Footer ở 

mục lục 



 

 

MỤC LỤC CÁC HÌNH VẼ 

Hình 4-1. Kiến trúc tổng thể ................................................................................. 16 

Hình 5-1. Use case của quy trình đặt hàng ........................................................... 19 

Hình 5-2. Use case của Nhân viên quản lý ........................................................... 20 

Hình 7-1. Sơ đồ quan niệm dữ liệu ...................................................................... 24 

 

 

Không có 

Header và 

Footer ở 

mục lục 



 

Đề tài: (GHI ĐỀ TÀI SINH VIÊN ĐANG THỰC HIỆN BẰNG CHỮ NGHIÊNG IN HOA) 1 

Chương 1. GIỚI THIỆU 

1.1 ĐẶT VẤN ĐỀ 

1.1.1 Giới thiệu bối cảnh chung của xã hội hay của đơn vị khai thác 

Những nhu cầu hay những khó khăn gặp phải hằng ngày. 

- On the Insert tab, the galleries include items that are designed to 

coordinate with the overall look of your document. 

- You can use these galleries to insert tables, headers, footers, lists, 

cover pages, and other document building blocks. 

- When you create pictures, charts, or diagrams, they also 

coordinate with your current document look. 

- You can easily change the formatting of selected text in the 

document text by choosing a look for the selected text from the 

Quick Styles gallery on the Home tab. 

Sự phát triển của công nghệ 

- On the Insert tab, the galleries include items that are designed to 

coordinate with the overall look of your document. 

- You can use these galleries to insert tables, headers, footers, lists, 

cover pages, and other document building blocks. 

- When you create pictures, charts, or diagrams, they also 

coordinate with your current document look. 

1.1.2 Sự phát triển của công nghệ 

- On the Insert tab, the galleries include items that are designed to 

coordinate with the overall look of your document. 

- You can use these galleries to insert tables, headers, footers, lists, 

cover pages, and other document building blocks. 

- When you create pictures, charts, or diagrams, they also 

coordinate with your current document look. 

1.2 MỤC TIÊU CỦA ĐỀ TÀI 

Nêu những mục tiêu chính của LVTN, giới hạn phạm vi ứng dụng. 

Trang đầu của 

mỗi chương 

không có 

Header 



Chương 1. GIỚI THIỆU 

Đề tài: (GHI ĐỀ TÀI SINH VIÊN ĐANG THỰC HIỆN BẰNG CHỮ NGHIÊNG IN HOA) 2 

 

Nội dung tiếp theo chương 1… 

 

Các trang 

tiếp theo của 

chương thì 

có Header 



 

Đề tài: (GHI ĐỀ TÀI SINH VIÊN ĐANG THỰC HIỆN BẰNG CHỮ NGHIÊNG IN HOA) 3 

Chương 2. MÔ TẢ NGHIỆP VỤ 

2.1 TỔNG QUAN 

2.1.1 Giới thiệu 

2.1.1.1 Giới thiệu chung về đơn vị: 

On the Insert tab, the galleries include items that are designed to coordinate with the 

overall look of your document. You can use these galleries to insert tables, headers, 

footers, lists, cover pages, and other document building blocks. When you create 

pictures, charts, or diagrams, they also coordinate with your current document look. 

2.1.1.2 Chức năng 

-  

-  

2.1.1.3 Lãnh vực hoạt động 

-  

-  

2.1.1.4 Cơ cấu tổ chức 

2.1.2 Cơ cấu tổ chức 

          Nội dung tiếp theo chương 2… 

2.2 QUY TRÌNH ĐẶT HÀNG 
 

 

 

 

 

 

 



Chương 2. MÔ TẢ NGHIỆP VỤ 

Đề tài: (GHI ĐỀ TÀI SINH VIÊN ĐANG THỰC HIỆN BẰNG CHỮ NGHIÊNG IN HOA) 4 

 

 

 

 

 

 



 

Đề tài: (GHI ĐỀ TÀI SINH VIÊN ĐANG THỰC HIỆN BẰNG CHỮ NGHIÊNG IN HOA) 5 

PHỤ LỤC 

[1] Abc. 

[2] Def. 

[3] Ghi. 

 



 

Đề tài: (GHI ĐỀ TÀI SINH VIÊN ĐANG THỰC HIỆN BẰNG CHỮ NGHIÊNG IN HOA) 6 

 

TÀI LIỆU THAM KHẢO 

[1] Tác giả 1, tác giả 2 (năm xuất bản). Tên sách/tài liệu, Nơi xuất bản. 

[2] Sử dụng style “Tai lieu tham khao” 

[3]  


